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Purpose of Session 

• Increase your capacity to develop effective 
presentations that will help  

– Achieve your desired outcomes 

– Incite action to move forward  
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Overview of Training  
• Part 1: The Basics 

– Purpose of PPT 

• Part 2: Developing Your Content 
– Overall structure 
– Content 
– Format 
– Graphics 
– Quiz 

• Part 3: Using the AFP SMART Template and PPT 
Functions 
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THE BASICS 
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Why Use PPT? 
• Helps to organize your presentation and guide your 

audience 

• Serves as a visual aid to emphasize key points 

• Can keep your audience engaged during and following 
the presentation 
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DEVELOPING YOUR CONTENT 
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Organize Your Thoughts First 
• Assess your audience—current interests, level of knowledge, work 

environment/habits, etc. 

• Identify the outcomes and actions you and the audience desire 

• Identify your key points that will lead to these outcomes and then 
what information is central to making these points 

– Create an outline and determine the number of slides needed for each 
topic OR 

– Diagram your slides, labeling each with the main topic 
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Organize Your Thoughts First 
• Think of ways to link your key points, for example  

– Use a numerical value (e.g., 5 pathways to achieving…) 

– Use an overarching phrase (e.g., “social vaccine”) 

– Provide examples (even from other countries) 

• Think outside the box!  
– Quotes, infographics, exercises, fill in the blank, video clips, etc. 

• Determine whether the information can be presented 
within your timeframe and cut tangential info, as needed 
– Account for 1–2 minutes per slide, depending on complexity  

8 



Structure Your Presentation 
• The opening 

– Announce your topic and objective clearly 
– Try to use humor to engage the audience 

• The middle 
– Organize the presentation around your key topics, using 

transition/divider slides  

• The closing  
– Summarize your main points and take-home messages 
– Encourage action, when appropriate 
– Thank the audience and solicit questions, when appropriate 
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Present Clear Content 
• Introduce only one main idea per slide  

• Guide the audience by using divider slides and SHORT headings 
and subheadings 

• Stay under 8 lines of text and 6 bullets per slide (try!) 

• Place dependent information in the same bullet 

• Don’t be verbose, but don’t be cryptic either 

– Include the fundamental information on your slide 
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Present Clear Content (cont.) 
• Be consistent in the use of 

– Structure for headings and bullets (e.g., nouns or verbs; full sentences 
or phrases; past or present) 

– Titles of organizations, names, documents, etc. 

– Abbreviations (spell out on first mention) 

– Capitalization for headings and titles 

– Punctuation for at least each slide (e.g., periods or no periods) 

– Spelling (inc. British spelling vs. American spelling) 
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Present Clear Content (cont.) 
• Ensure that all tables and figures are accurate and easy to 

understand 

– Review your presentation for discrepancies or disconnects between 
data and corresponding text  

– If a table/figure cannot be immediately understood, add a short 
summary statement to capture its full meaning or narrow down what is 
shown (simplify) 

– Make sure all necessary elements of a figure are labeled 

– Cite the sources for all tables and figures  
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Use Relevant, Appropriate Visuals 
• Create a balance between content and visuals 

• Make sure photos and graphics are relevant and appropriate for the 
content and country or region represented 

• Include credits for all photos and outsourced graphics and ensure 
that consent and permission requirements were followed 

• Avoid clip art for high-level, technical presentations 

• Do not mix photos and clip art 
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Use a Simple, Effective Format 
• Use font types and sizes for headings, text, and figures consistently 

and sparingly 

• Use colors consistently and sparingly (inc. across figures and in 
backgrounds) 

• Restrict the use of bright colors such as yellow and orange to small 
highlights (not slide backgrounds or whole paragraphs) 

• Use contrasting colors (not dark on dark or light on light) 
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Use a Simple, Effective Format (cont.) 
• Check your colors on a projector screen 

• Maintain some white space (at the top, between bullets, and 
between text and graphics) 

• Do not shrink down tables or figures to illegible sizes to fit them on a 
slide 

• Do not enlarge photos or graphics of poor resolution to fill a space 
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Add Simple Transitions/Animations 
• They serve a purpose—they are not just fancy and fun 

– Keep your audience engaged and focused on the current point 

– Allow the audience to visually follow your train of thought 

• Keep to the simple ones (e.g., “appear” or “fade”); other kinds will 
add time and/or distract your audience 

• Do not add them until your PowerPoint presentation is finalized 

• Make sure you know where your transitions occur 
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Keep Your Audience Engaged 
• Rehearse, reduce, and pre-test 

• Keep your tone conversational; do not just read the slides 

• Be animated and enthusiastic; use humor and anecdotes when 
appropriate 

• Do not talk too fast 

• Make eye contact frequently 

• Avoid too much movement; do not pace 

• Allow for some interaction with the audience, if possible 
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Quiz! 

• Identify the problems in the next several slides 
and you could win a prize! 
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Outreach Location, by Country, 
2012 
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Greatest outreach achieved in private 
homes and street/blocks  
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Source: Health Policy Project. 2014. The Cost of HIV Prevention Interventions for Key Populations in the Eastern Caribbean and Barbados. 
Washington, DC: Futures Group, Health Policy Project. [FAKE SOURCE FOR TRAINING] 



Cost drivers by country, Antigua and 
Barbuda 
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Cost drivers, Antigua and Barbuda 
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Adult (15–49 years) HIV prevalence over time in 
Ukraine, 1986–2013 
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HIV prevalence in Ukraine    
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Source: The World Bank Group. 2014. Word Bank Open Data. Washington, DC: The World Bank Group. [FAKE SOURCE FOR TRAINING}  



Indirect Costs 
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UNIT COSTS per patient/month 

Programs: Hai 
Phong and 

HCMC 
CDC-supported 

sites in HCMC 

Central & provincial management 
               
2.63  

                 
1.31  

Site operation and maintanance  0.62  2.36  

Drug import and distribution 0.40                     -    
• Overall, program management accounts for 8.6% of the total costs 

• Site operation and maintenance account for only 2% of the total indirect costs for the 
programs, but 7% for the CDC-supported sites, which is closer to expectation 

• Drug importation and distribution costs are minor in comparison 



Indirect Costs 
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Unit Costs per Patient/Month 
Programs: Hai 

Phong and HCMC 
(US$) 

CDC-supported 
Sites in HCMC 

(US$) 

Central and provincial management 2.63  1.31  

Site operation and maintenance 0.62  2.36  

Drug import and distribution 0.40  -    

Source: Health Policy Project. 2013. Costing Report. Washington, DC: Futures Group, Health Policy Project. [FAKE SOURCE FOR TRAINING}  



Timeline 
• December 1975: Indonesia invades East Timor 
• July 1976: Indonesia declares East Timor its 27th province 
• For next 25 years: Armed Forces for the National Liberation of East Timor (FALINTIL) 

resists Indonesian occupation, and at least 100,000 lives are lost 
• August 1999: The Timorese vote for independence in a UN-sponsored referendum, 

and pro-Indonesian militias respond with campaign of terror, killing thousands and 
displacing close to 300,000 

• Late 1999 (following August vote): The Australian-led International Force for East 
Timor (INTERFET) and the United Nations Transitional Administration in East Timor 
(UNTAET) move in and work to restore order 

• 2000–2002: More than 200,000 refugees return to East Timor 
• May 20, 2002: The country officially becomes the Democratic Republic of Timor-

Leste; Xanana Gusmão is sworn in as president  
• 2006: There is renewed civil strife leading up to the 2007 presidential election; 15% of 

the population flees their homes and UN peacekeeping forces are sent back in to 
reinstate order 

• February 2008: Attempted assassination of President Ramos-Horta; renewed 
outbreaks of violence 

• December 31, 2012: The UN peacekeeping mission ends, following the gradual 
hand-off of control to the police force and Timorese authorities 
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Timeline 

28 



Health Indicators 
• Maternal Mortality Ratio (MMR): 557 deaths per 100,000 live births 
• 1 in 16 children die before their fifth birthday 
• Just over half of Timorese children are chronically malnourished 
• 70% of births are not attended by a skilled provider 
• 78% of deliveries take place in the home 
• Total Fertility Rate (TFR): 5.7 births per woman 
• Nearly half of women give birth by the age of 22 
• 31% of women report an unmet need for family planning  
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Health Indicators 

• [Key statement] 
 

• [Source]  
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In Summary… 
The effectiveness of your presentation will depend on how 
well you have 

• Thought through the audience, purpose, and desired outcomes 

• Structured your content logically, making it easy to follow 

• Developed clear and focused content that includes main take away 
messages and/or encourages action 

• Formatted your presentation to avoid distracting your audience 

• Used a balance of relevant and appropriate visuals and transitions 

• Practiced giving the presentation 
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USING THE AFP SMART  
PPT TEMPLATE 
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Using the AFP SMART Template  
• Main slide types 

• Inserting a slide 

• Switching/resetting a slide 
layout 

• Adjusting the speaker notes 
format 

• Using the  AFP SMART 
theme colors 

 

• Inserting and adjusting 
photos and figures 

• Using transitions and 
animations 

• Reducing file size 
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AFP SMART Slide Layouts 
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Cover and End Slides 
• The cover slide should be the 

first slide in your presentation 

 

• The last slide in your 
presentation should be the  
end slide 
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Title and Content 

 Bullet 1 
 Bullet 2 

 Bullet 3 
 Bullet 4 

o Bullet 5 



Text and Content 

 Click to enter text 

 



Title and Picture or Object 



 Click to enter text 

Text and Photo 



 Click to enter text   Click to enter text 

Text (Two Column) 



Click to enter section title 

 Click to enter section subtitle 



Phase 1 
Build 

Consensus 

Step 1 
Decide Who to 

Involve 

Step 2 
Set SMART 
Objective 

Step 3 
Identify the 

Decisionmaker 
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Phase 2 
Focus Efforts 

Step 4 
Review the 

Context 

Step 5 
Know the 

Decisionmaker 

Step 6 
Determine the 

Ask 
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Phase 3 
Achieve 
Change 

Step 7 
Develop a 
Work Plan 

Step 8 
Set 

Benchmarks 
for Success 

Step 9 
Implement and 

Assess 
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Inserting a Slide 
• To insert slides—click on New Slide arrow on Home tab 

and select slide from templates 
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Inserting Slides from a Different 
Presentation 
• Select New Slide and at the bottom of the pull-down menu select 

Reuse Slides 

• Select Open a PowerPoint File from the menu that  
pops up  

• The slides from the other presentation will appear on the right side 
of your screen; selecting a slide from the menu will insert the slide 
into your current presentation 
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Switching a Slide Layout 
• To switch the layout of a slide, make sure you have selected the 

slide you want to change 

• On the Home tab, click on the Layout pull-down menu and select the 
new layout; the new layout will be applied to your slide! 

• You can also change the layout of a slide by right-clicking and 
selecting the new layout that you want to use 
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Resetting a Slide Layout 
• To go back to default slide formatting—right-click the 

slide and select Reset Slide 
 

52 



Adjusting the Speaker Notes Format 
• The easiest way to insert, review, and format speaker 

notes is via the Notes Page view 

• Click on View and select Notes Page 
 
 
 
 
 



Using the AFP SMART Theme Colors 
• Colors from the AFP SMART color palette have been 

preloaded into the template  
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Inserting Photos 
• Use one of the photo layouts from the AFP SMART 

template  

• Double-click on the photo icon and insert a  
photo from your files 

• Be sure to include a photo credit!  
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Adjusting Photos 
• Changing photo size 

– Shift + drag the sizing handle in one of the photo’s corners 

• Replacing photos (use Change Picture button on  
Format tab) 

– You can also right click the photo, and select “change picture” 

• Removing background and cropping photo 

– Pictures Tools/Format  → Remove Background 
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Inserting Figures 
• To insert a figure—copy the graph from Excel (ctrl+c). 

Right-click and select Keep Source Formatting and 
Embed Workbook under Paste Options 
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Inserting Tables 
• To insert a table from a Word document into PPT, select the table 

and then copy and paste it onto your slide 

• To create a new table in PPT, click on the Home tab and the Table 
arrow and select the number of rows and columns needed 

• With your table selected, format as needed using the Design and 
Layout tabs located under Table Tools 
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Using Transitions and Animations 
• Transitions and animations help to reveal points as you  

cover them 

• Use animation for specific objects and transitions to move to your 
next slide 

• You can add animations, time them, change their order, and preview 
your work through the Animation tab on the ribbon 

• Add animations and/or transitions to enhance your presentation, 
they shouldn’t distract your audience 
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Reducing File Size 
• Compress your photos in the PPT file; click on a photo, select the 

Format tab under Picture Tools and choose Compress Pictures 

• If your presentation contains audio or video, compress the file size: 

– File Info Compress Media  

• You can also do a Save As—saving your presentation a second time 
and renaming it removes extra data 
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www.futuresgroup.com 
www.facebook.com/FuturesGroup 
www.twitter.com/FuturesGroupGbl 

61 


	Bring Out the Power in PowerPoint
	Purpose of Session
	Overview of Training 
	The Basics
	Why Use PPT?
	Developing Your Content
	Organize Your Thoughts First
	Organize Your Thoughts First
	Structure Your Presentation
	Present Clear Content
	Present Clear Content (cont.)
	Present Clear Content (cont.)
	Use Relevant, Appropriate Visuals
	Use a Simple, Effective Format
	Use a Simple, Effective Format (cont.)
	Add Simple Transitions/Animations
	Keep Your Audience Engaged
	Quiz!
	Outreach Location, by Country, 2012
	Greatest outreach achieved in private homes and street/blocks 
	Cost drivers by country, Antigua and Barbuda
	Cost drivers, Antigua and Barbuda
	Adult (15–49 years) HIV prevalence over time in Ukraine, 1986–2013
	HIV prevalence in Ukraine   
	Indirect Costs
	Indirect Costs
	Timeline
	Timeline
	Health Indicators
	Health Indicators
	In Summary…
	Using the AFP SMART �PPT Template
	Using the AFP SMART Template 
	AFP SMART Slide Layouts
	Cover and End Slides
	Title and Content
	Text and Content
	Title and Picture or Object
	Text and Photo
	Text (Two Column)
	Click to enter section title
	Slide Number 42
	Slide Number 43
	Slide Number 44
	Slide Number 45
	Slide Number 46
	Slide Number 47
	Number Graphic
	Inserting a Slide
	Inserting Slides from a Different Presentation
	Switching a Slide Layout
	Resetting a Slide Layout
	Adjusting the Speaker Notes Format
	Using the AFP SMART Theme Colors
	Inserting Photos
	Adjusting Photos
	Inserting Figures
	Inserting Tables
	Using Transitions and Animations
	Reducing File Size
	Slide Number 61

